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Presentation 
Design



Presentations don’t 
have to be hard

You don’t have to be a PowerPoint expert to create 
great presentations. With a few basic principles 
and some simple tips and tricks, you can elevate any 
presentation from basic and boring to unique 
and engaging.

In our Basics of Presentation Design eBook, you’ll 
discover the essentials of creating amazing slides in 
less time, the techniques to turn bullet points into 
stories, and the tools to improve every presentation 
that comes across your desk.

Here’s what you’ll learn
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Storytelling will give you tools to turn ordinary 
content into clear narratives that grab attention, 
and some story structures to make it easy to craft 
new slides.

Typography goes deep on the ins-and-outs 
of choosing and using fonts.

Images explains the different types of images 
used in presentations, and best practices 
for finding, choosing, and using images on 
your slides.

Presentation Design will cover what makes 
slides so unique, how to get started with 
content, and the basics of laying out a slide.

Templates gives you a step-by-step 
breakdown of how to build a template, 
so you can set every presentation 
up for success.

Color covers how to think about color 
in presentations, as well as ways to use 
colors effectively.

Motion is an introduction to all things 
animation in PowerPoint, including 
slide transitions and easy ways to get 
started with using animations.
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Presentation 
Design 101
What makes presentation design 
different from other types of design 
comes down to a single word: slides

Slides are the heart and soul of a presentation, 
and while they may seem straightforward, 
they actually are a unique format, with their own 
conventions, expectations, and techniques.
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Welcome to the first part of our guide covering 
Presentation Design 101, an exploration of the basic 
principles that make presentations unique and 
how you can use them to give better presentations.

If you want to get better at building presentations, 
you need to start with the basics. So, let’s dive into 
the world of slides, and learn what makes them 
so special, and some of the ways you can get more 
out of every slide in your presentation.

Basic principles that make presentations unique

Let’s start with the most basic question you can 
ask about presentation design: what makes a slide 
“good”? Is it an eye-catching design? Sharp, 
insightful copy? Carefully chosen photography? 

What makes a slide effective
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It can be those things, but the best measure 
of a slide’s effectiveness is how well it conveys 
your information. And the best way to ensure 
your slides are getting the point across is 
to have your content and design working 
together to tell your story. 



Start with an outline One idea per slide

Content principles

A presentation is a tool for conveying information. 
That information, or your content, should be the first 
thing you consider, and will dictate what your slides 
look like and the approach you take to creating them.

A presentation is a tool for conveying information. 
That information, or your content, should be the first 
thing you consider, and will dictate what your slides 
look like and the approach you take to creating them.

Here are a few ways to think about 
creating clear, effective content 
for your presentations:
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Idea 1 Idea 2 Idea 3

Idea 1

Idea 2

Idea 3

Creating an outline will help you to organize your 
thoughts and start to structure the flow of your 
presentation. You can identify the key idea you 
want to cover on each slide, and then start to piece 
together the supporting material you’ll use. 



Content principles

The standard practice in PowerPoint is to rely on slide 
titles that describe what’s on the slide: Agenda, Results, 
Strategy, etc. While these aren’t exactly wrong, relying 
on basic descriptive titles does miss a big opportunity 
to tell a richer, more engaging story. There are two 
basic ways to tell a story in a headline. 

First, all of the headlines across your slides can tell 
a continuous story.

With this approach, the presentation becomes a story 
as you lead your audience from start to finish across 
multiple slides.

Second, each slide can be self contained. 

In this approach, you’ll still use story-driven headlines, 
but they won’t need to connect directly to the other 
slides. This can be helpful when you have a lot 
of different types of content, for example if you were 
collecting materials from multiple presenters into 
one presentation.

Use headlines, not titles
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It was the best of times It was the worst of times It was the age of wisdom

It was the age of foolishness It was the epoch of belief It was the epoch incredulity

It was the season of Light It was the season of Darkness It was the spring of hope



Content principles

As you can see, it’s not a huge difference, but 
it communicates much more information and 
starts to tell a clearer story than the originals.

HEADLINESTITLESHere are two examples of the 
difference between basic descriptive 
titles and story-driven headlines:

7 VerdanaBold Guide  |  Presentation Design 101



There are a handful of simple yet effective ways 
to structure your content, so if you’re not sure 
where to start or prefer to have a plan, you can 
try these as starting points for developing tight, 
clear content.

5x5 Rule
With the 5x5 rule, your goal is to keep slides 
to a maximum of 5 bullet points, with only 5 words 
per bullet.

For every slide, no more than 5 bullet points 
with no more than 5 words per bullet point.

7x7 Rule
Similar to the 5x5, the 7x7 rule limits you to 7 lines 
of text per slide, and 7 words per line.

For every slide, use no more than seven lines 
of text — or seven bullet points — and no more than 
seven words per line. Slide titles aren’t included in 
the count.

Content principles

Techniques
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Content principles

10/20/30 Rule

This rule covers your presentation as a whole, 
not just the individual slides. With this approach, 
you keep the entire presentation to just 10 slides, 
with a run time of 20 minutes and a minimum 
font size of 30 points. 

This is an aggressive approach that will challenge 
you to think hard about what you really want 
to say, and how much time you really need to say it. 
You might not actually use this when presenting, 
but it’s a powerful exercise for forcing you to take 
a closer look at your content.

Techniques

10 slides max 20 minutes max 30 points min
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Content principles

Adjusting your content to the setting

While all of these rules are useful, they can’t be 
applied universally, at least not without a bit 
of extra consideration for the type of presentation 
you are giving. Depending on how you’re 
presenting, you should tailor the amount and 
type of content to suit that particular setting.

We define three main types of presentation: 
Keynote or large room, hybrid/virtual, and 
leave behind. These three categories represent 
the main ways people present, and each one 
needs a slightly different approach to content. 
Here are a few ways to think about editing 
your content for each type of presentation:

Techniques

Visual

Simple

Light

Scannable

Concise

Approachable

Informative

Detailed

Comprehensive
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Keynote Hybrid Leave behind



Design principles

Effective slides all have one thing in 
common: the visuals support the story

Beautiful slides can be a great asset in 
a presentation, but if they’re not adding 
to your story, they’re actually getting 
in the way. Using your visuals to support 
and enhance your content is called visual 
storytelling, and it’s all about making 
every element on a slide work for you.

While you don’t need to be a professional 
designer to create aesthetically pleasing 
presentations, it does help to understand 
a few of the basic principles of design. These 
concepts will help you to understand how 
different elements work either alone or together 
on your slide and serve as a strong basis 
for evaluating layouts. 
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Design principles

Contrast
Contrast is the difference between various 
elements within a design that makes them 
stand out from each other.

Proportion
Proportion refers to the size of elements in relation 
to one another. Larger elements tend to be seen 
as more important while smaller ones are less so. 

Emphasis
Emphasis causes certain parts of a design 
to stand out compared to other elements. 
Conversely, it can also be used to minimize 
how much an element stands out (such 
as fine print). In this example, we’re using 
color to emphasize one element on the slide.
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Design principles

Hierarchy
Hierarchy uses principle elements such as size, 
placement, color, or emphasis, to give visual cues 
about which elements are of primary importance, 
secondary, and so on.

Negative space
With negative space, you are creating a design 
element out of unused space, rather than designing 
an object. This way, your element is created out 
of the background.

Negative space is similar to, but different from, white 
space. White space refers to the area of a design that 
is left unfilled by elements. In other words, it’s all the 
space you don’t use. White space is an important 
concept for creating balanced and scannable layouts.

Movement
Movement is the way a person’s eyes travel across 
a design. The most important element should 
lead to the next most important and so on. Much 
like hierarchy, this can be done via positioning, 
emphasis and other design principles.
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Design principles

When a slide is “scannable,” it’s easy for the audience  
to understand the content at a glance. That means a 
clear, story-driven headline, visuals that support the 
content, and a layout that’s easy to follow.

A scannable slide illustrates the tight relationship 
between content and design, and shows why it’s 
so important for the two areas to work in harmony.

Scannability
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Design principles

A good slide is built on a foundation 
of consistency. By taking the time to ensure 
things like margins, placement of headers 
and logos, and use of typefaces and colors 
are all consistent, you can help ensure that 
the audience stays focused on your content.

Here are some examples of good (and bad) layouts, focused on consistency:Consistency and layouts
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B A D G O O D



Design principles

No matter how well edited or laid-out your content 
is, the audience won’t connect if they aren’t engaged. 
Our next rule is to use visual pacing to vary the look 
of your slides.

The reason is that if all of your slides look the same, 
your audience will quickly lose interest in them. 
By using different background colors, typography 
and photography to set visual pacing, you create 
small changes that stimulate the eye and maintain 
engagement, as opposed to a series of identical 
slides that all bleed together.

This is a delicate balance between visual interest 
and overdesign. Your goal isn’t to make every slide 
totally unique. Instead, you should create a few slide 
types, and vary those according to your content.

Visual pacing
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Design principles

Here’s an example of how visual pacing would 
look across a presentation. Note how the color 
scheme and slide layouts are consistent, and how 
certain types are repeated. This creates enough 
variety to keep the audience interested, but 
doesn’t reinvent the wheel each time.
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Best practices

We’ve given you a quick education 
on the basics of presentation design, 
but it’s not all theory and ideas. 
There are also some best practices 
that our presentation designers 
use to improve slides.
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Best practices

Adding in a photo can help illustrate a point or add 
visual interest. Adding a photo with people in it can 
humanize a presentation.

But pictures don’t always improve a slide. If they are 
low quality (pixelated, poorly composed, etc.), don’t 
match the content, or there are just too many of them 
on a slide, the result is often worse than a slide with 
no images. 

Our best practice is to pick one good image per slide.

Using pictures
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Best practices

Animation can add excitement and even help reinforce learning, 
but it can also be distracting. Our best practice is to stick to simple 
fades (or no animation at all) whenever possible.

Using Fade transitions

Much like with animation, transitions work best when they are 
simple. Our best practice is to use a simple fade transition between 
slides. It’s one of the easiest ways to add polish to a presentation.

Color is a powerful tool in presentation design, but overusing it is a quick way 
to turn your presentation into a circus. Your brand likely has an established 
color palette you should follow, but even then, our best practice is to stick 
to two (or three max) colors, with any others used sparingly as accents.

Keep animation simple Don’t use too many colors
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Best practices

Some presentation creators make the mistake of thinking that using multiple fonts will add 
visual variety to a slide. Instead, it just makes slides feel cluttered and inconsistent. 
Our best practice is to stick to a single typeface, ideally a system font, to maintain clarity 
and readability of your presentation.

One type face (Arial in this example) often creates a more professional look

Non-System fonts can result in unpredictable 
substitutions. System fonts (like Arial, Calibri, or 
Georgia) ensure compatibility when sharing with 
others

Don’t overuse fonts/typefaces
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Learning the basics of presentation design and slide 
layouts doesn’t have to be complicated. With these 
key ideas, you can see immediate changes to the overall 
clarity and design of your presentations.

Summary

Conclusion

Despite the ubiquity of PowerPoint in business, the 
basics of slide and presentation design are often 
misunderstood (or never taught at all). But it doesn’t 
take a lot of time or education to learn skills that will 
make your slides clearer, your stories stronger, and 
your presentations more effective.

• One idea per slide

• Tell a story with headlines

• Follow content and design principles

• Consistent placement

• Consistent margins

• Keep audiences engaged with visual pacing

• Pick 1 good image per slide

• Use animation sparingly

• Add Fade transitions between slides

• Don’t overuse colors or fonts
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Looking for more information about presentation 
design and beyond? Check out our resources for 
expert advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks


Storytelling 
101
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The word “storytelling” can be both blatantly 
overused and frustratingly vague. But those 
things don’t also mean that it’s not a valuable 
addition to your presentation toolkit.



Introduction to Presentation Storytelling

Storytelling is all about the flow and structure of your 
presentations. It’s about adding context to information 
and organizing your slides in a way that adds up 
to a larger point. Most of all, it’s about creating 
presentations that more effectively communicate 
your information while doing it in less time. And in 
our experience, storytelling is one of the most effective 
yet misunderstood tools that a presenter can use.

So, let’s dive into Storytelling 101, and learn more 
about what it is and how you can use it to enhance 
your presentations.
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One of the reasons that PowerPoint became such 
a successful model for creating presentations 
is that using slides makes it easy for creators to 
organize their content. You have an Agenda 
slide, a Features slide, a Results slide, etc. It’s all 
very neat and clean and makes it easy for people 
to swap slides or rebuild existing presentations 
for new audiences.

But there’s a problem with this approach. When 
you design each slide as its own self-contained 
idea, what you end up with is not a clear story 
with a defined arc. Instead, the result is a series 
of one-off slides, with no flow, transitions, 
or narrative.

Why storytelling matters

When you think about it this way, it’s easy to see 
how and why most presentations don’t tell a story. 
It’s not because stories are hard to tell, but rather 
that the medium itself doesn’t encourage the sort 
of flow that a story requires.

With presentation storytelling, you think about the 
presentation as a whole and not just the individual 
slides. You need to look at the order of your ideas, 
how the content on each slide fits with the others, 
as well as how each individual slide works on 
its own. 



How do I get started with Presentation Storytelling?

While there are some specific techniques and frameworks you can apply to add storytelling to your presentations (we’ll cover those in a bit), 
the simplest way to approach it is to think about showing what will change as a result of your presentation.

At its most basic level, a story describes change. For example, here’s a very simple version of the Hero’s Journey:
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A young girl lives in a village that is 
terrorized by a dragon
The dragon is said to be nearly indestructible

The villagers are living in fear

The young girl is determined to slay the beast

She leaves home to defeat the 
evil dragon
She sets out with fierce determination to succeed

Despite the odds against her she refuses to give up

On her journey she encounters challenges that test her 
courage and resolve 

Along the way, she learns to fight

She learns techniques and strategies

She befriends a group of adventurers 
who join her on her quest

Together, they journey through treacherous 
forests and scorching deserts, facing dangerous 
beasts and solving challenging puzzles

She slays the dragon

The villagers are overjoyed and throw a 
huge celebration

She is hailed as a hero for her bravery 
in the face of danger

She gets rewards and treasurers beyond 
her wildest dreams

Now, let’s look at that same arc in professional setting:

A large brand dominates a market

The brand has the largest market share

They’ve survived many challenger brands

The brand has a long history and has been a market 
leader for many years

A new competitor is formed 
and launches a product

A group of entrepreneurs with a fresh approach 
to the market forms a new company

It launches a product with the goal of challenging 
the dominant brand

They face obstacles at each step of the launch

They improve their offering 
and build a brand

The company continuously improves its product

They invest in marketing to establish their brand

Brand campaigns and audience engagement 
expand the brand to new areas

Today, they are leaders in the market

The new company has overtaken their competitor

They have a growing customer base and a 
reputation for great products

They create value for the stakeholders



A large brand dominates a market

The brand has the largest market share

They’ve survived many challenger brands

The brand has a long history and has been a market 
leader for many years

A new competitor is formed 
and launches a product

A group of entrepreneurs with a fresh approach 
to the market forms a new company

It launches a product with the goal of challenging 
the dominant brand

They face obstacles at each step of the launch

They improve their offering 
and build a brand

The company continuously improves its product

They invest in marketing to establish their brand

Brand campaigns and audience engagement 
expand the brand to new areas

Today, they are leaders in the market

The new company has overtaken their competitor

They have a growing customer base and a 
reputation for great products

They create value for the stakeholders

In both examples, we see the same arc 
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1 2 3 4

At a high level, this is essentially what presentation storytelling means: 
organizing your content to tell a larger story than what’s on the individual slides. 

Where things start Where things are going How we’ll get there What happens at the end



What are some specific 
techniques I can use 
to improve my storytelling?

VerdanaBold Guide  |  Storytelling 10127

The big truth about presentations 
is that each one is unique. That 
means no framework, no matter how 
comprehensive or well-designed, 
is going to work for every story you 
want to tell. That said, there are some 
great techniques you can apply and 
a few specific tactics that we’ve found 
to be useful tools for crafting stories.



What are some specific techniques I can use to improve my storytelling?
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First, streamline your content. 
Even if you have a clear story, it can get lost in the mix if every slide is crammed 
with bullets and icons. There’s an idea in learning and development that 
says “slides are for sharing ideas, not teaching them.” Your goal on a given 
slide is not to try and force your audience to recall every line you added 
to the slide – instead, it’s to gently guide them to the big idea you want 
to convey. 

Focus on conveying your key message and leave the rest for
 a follow up document.

Before we get into specifics, let's go over some best practices for writing presentations.  Regardless of the technique you use, or the 
brilliance of your idea, these two tips are a great place to start for any presentation writer.

Second, write benefit-driven headlines. 
The traditional slide title is, to be honest, bad. If you’ve ever sat through 
a presentation that led with nothing but basic descriptions that just tell 
the audience what is on the slide, you’ll understand. Titles don’t convey 
a key message, they don’t highlight a takeaway, and they don’t help 
to advance your story. 

Instead, you can use your titles to highlight the benefit to the audience. Earlier 
in this document, we said that a story shows change. A benefit explains 
to the audience what will change as a result of choosing your brand. That 
means that using benefits is a simple way to add storytelling techniques 
to any piece of writing, even if you aren’t connecting a larger narrative.

A young girl lives in a village that is terrorized 
by a dragon

A girl’s village is terrorized by a dragon

The dragon is said to be nearly indestructible, with scales 
as hard as steel and breath that can melt metal

The villagers are living in fear and despair, as the dragon 
regularly comes to the village to demand tribute in the form 
of gold and livestock

The young girl is determined to put an end to the dragon’s reign 
of terror and decides to embark on a quest to slay the beast

The dragon is said to be nearly indestructible

The villagers are living in fear

The young girl is determined to slay the beast

Results Today, they are leaders in the market

The new company has successfully established itself as a leader 
in the market by challenging the dominant brand

They have a growing customer base and a reputation for quality 
and innovation

Their products are highly sought after, and they continue to expand 
their product offerings and grow their brand

The new company has overtaken their competitor

They have a growing customer base and a reputation for great products

They create value for the stakeholders

AFTERBEFORE AFTERBEFORE



SCQA
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SCQA, or Situation-Complication-Question-Answer, is a framework that’s widely used in the consulting industry, and offers 
a clear, simple approach to structuring a story. Starting from your main idea, you can build out your presentation to follow this 
order, and the result will be a straightforward story that offers your audience an easy-to-understand outcome. 

A N S W E R

SHOPPR offers fast 
delivery for free

Q U E S T I O N

What if we brought 
the groceries to them?

S I T U A T I O N

Shopping for groceries 
is essential

C O M P L I C A T I O N

People have less time 
to go shopping

Using this framework, you’ve added context to your main idea, shown a benefit to choosing you, 
and framed your information as a story. Best of all, you can do it all without any boring slide titles.

Here’s an example:
Say you are trying to pitch investors on your new shopping app. 

F R A M E W O R K  # 1



The Reveal
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A common form of narrative storytelling 
is to build up to the main point. Think of a great 
book or a favorite movie that leaves you on the 
edge of your seat until the last minute. In this 
framework, information is slowly shared across 
the entire work, and tension is built until 
the final moment.

F R A M E W O R K  # 2



The Back up
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This style is more like a mystery that starts 
with the murder. You know what happened, 
but all the other details are a story to be 
unraveled slide by slide. 

You’ll notice that this approach uses the same headlines to tell two very different stories. 
By inverting the order, you can shift the emphasis to suit your unique story and style.

F R A M E W O R K  # 3
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This simple framework helps you look at an issue from multiple perspectives, and your story is how you navigate through them.

With this technique, you organize your presentation through the lens of scale, and zoom in (or out) to get the full story. 

For example, here are two ways that you might frame up a topic:

M A C R O

Corporate strategy

M I C R O

Product strategy

A T O M I C

Activation tactics

M A C R O

Global context

M I C R O

Industry trends

A T O M I C

Enterprise trajectory

F R A M E W O R K  # 4

Macro/Micro/Atomic



Conclusion

Storytelling is simpler than it seems, and can elevate 
the quality of your presentations as well as your professional 
communications in general. With a few basic techniques 
and the willingness to let go of your expectations about 
what a story is or what a slide needs to sound like, you can 
become a storytelling pro in no time. 
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Looking for more information about presentation 
storytelling and beyond? Check out our resources for 
expert advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks
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Templates 
101
Whether you are a big brand that creates lots 
of presentations or just someone who wants 
to simplify the process, a PowerPoint template 
is a powerful tool for streamlining and 
improving the way you make presentations.



What is a PowerPoint template?

In this guide, we’ll go over what a template is, why they 
are useful, and how to use them for your presentations.
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Think of templates like a blueprint for your 
slides. A template lays out the basics – such 
as colors, fonts, backgrounds, and effects – 
across a variety of slide types, so you can 
easily create a well-designed and consistent 
presentation from scratch.

No more struggling to match brand colors 
or fussing with placement of logos. With 
a template, the basic layouts are completed 
in advance, so all you have to do is fill 
in your content.

PowerPoint templates 
are the foundation 
of great presentations.



What are the benefits of using a template?

PowerPoint templates make it easy for one person, 
or an entire organization, to create customized 
and engaging presentations. They offer greater control 
over branding elements and consistency, and reduce 
the amount of time users need to spend incorporating 
essential elements, since they are already built into 
the template.

36

Templates can influence every aspect 
of your presentations:

• How your fonts and colors display

• How your content shows up on screen 

• How your content prints

With a well-designed template, you can ensure consistent presentations 
that look pleasing and promote your brand, without the extra time 
or expertise needed to create custom presentations from scratch.
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How to make a PowerPoint template
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Create a blank presentation Select a slide size
Open PowerPoint and select New > Blank Presentation In the Design tab, select Slide Size and choose a default size—Standard (4:3)

or Widescreen (16:9). If you prefer a different size, you can create custom slide 
dimensions in Page Setup.

We recommend using the Widescreen size – 13.33”x7.5” (1280x720). 
This is the standard HD format accessible to most modern computer screens.



How to make a PowerPoint template
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Choose your page orientation Set up your Slide Master
Go to Page Setup > Orientation to set the orientation of your slides. 
The standard for most presentations is landscape.

The Slide Master is the primary slide image, and it appears at the top 
of the list. A Slide Master sets the standard for the rest of your slides, 
and contains the basic settings you want to apply, like colors or logos.

With a Slide Master, you can make one edit 
that is then applied to any associated layouts 
in your template. This gives you the flexibility 
to easily update a new logo across all slides 
with one change, for example.

Elements in the Slide Master are also safe 
from editing in Normal view (that is, the 
standard slide view). For example, if you 
set a logo in the master, people who are 
working in Normal view won’t be able 
to move it. To edit that element, simply 
go back to the Slide Master view.

The Slide Master is a great place to include 
common elements that you know will need 
to be on each slide, like logos, footers, dates, 
slide numbers, or even things like title and 
body copy text boxes.
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How to make a PowerPoint template
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Set up your layouts Create placeholders
If your Slide Master is the foundation for 
your presentation, layouts are the rooms 
in the house. Each slide layout is set up 
differently — with different types of 
placeholders in different locations on 
each layout.

Think of layouts as versions of the Slide Master 
that have been customized for specific types 
of content. Some will be for text-heavy slides, 
others for large images, etc.

Placeholders let you set spots for different types of content in your layouts. 
They can include text, images, charts and tables, videos, audio files, and more.

To add a placeholder, select the slide layout that you want 
to use, then:

• Click Insert Placeholder, and select the type of content you want to use

• On the Slide Master or slide layout, click and drag to draw 
the placeholder size
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Create a custom grid using guides
Using guides to create a grid is a simple and reliable way to align objects in your 
template (and on your slides in general). By placing your guides on the Slide Master, 
you can have them set in place and prevent users from accidentally moving them.

To turn guides on or off, right-click the slide background and choose Guides, 
or go to the View tab and select Guides.

PowerPoint also lets you customize your guides. You can color code them using 
the 10 default colors, and you can adjust the spacing down to as little as 0.01”.
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Create a custom color palette
Color is a key aspect of a branded template, and adding your brand colors 
is a great way to ensure consistency across users.

To create a custom color palette 
in your template, go to the Design 
tab, click the arrow under the 
colors section on the right, then 
click Customize Colors.

Next, click a color box to 
change its values. You can 
input an RGB or HEX value, 
or pick from a number 
of pre-selected color options. 

You can customize up 
to 10 colors for your palette.

Once you close the Colors 
window, select the Name 
box, add a name for your 
custom palette, then hit Save. 
This will apply the theme 
color to your presentation.
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The primary theme color palette 
is customizable and consists 
of 4 text/background colors, 
6 accent colors, and a hyperlink 
+ followed hyperlink color.

The color shades below theme 
colors are default palettes within 
the tool and are not customizable.

How to make a PowerPoint template
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Theme colors

Custom colors
It's possible to include up to 50 additional 
custom colors in the template. These colors 
appear in 5 rows of 10 colors each and can 
be named.

The colors labeled 'Standard Colors’ 
in PowerPoint are default palettes within 
the tool and are not customizable.
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You can also set the accent colors 
to customize the colors of any
charts or graphs used in your template. 
By default, PowerPoint will use 
the colors in boxes 5-10 in your list 
to fill out your data visualization.

The four options here don't have to be 
dark and light, as the name suggests, but it's 
recommended as background and text 
colors (including for charts & chart labels).

How to make a PowerPoint template
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Text/background colors

Accent colors
These are the main colors you'll use in your 
presentation, and all Charts and SmartArt 
will be created using these colors by default. 

Hyperlink color
Here you can choose a hyperlink color 
and a color for links that have been 
clicked. Note that the colors won't appear 
in the theme color menus.
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An important aspect of your template 
is backgrounds. To set a background on 
your slide master or layout, go to the 
Slide Master tab, click Background Styles, 
and choose your preferred background.

How to make a PowerPoint template
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Apply background styles

To make changes to the background 
of your slide master or slide layouts, 
on the Slide Master tab, click Background 
Styles, and choose a background.

For more control over the background, you 
can adjust other options by clicking Format 
Background. Here, you can change colors, 
textures, patterns, or even images. You can 
also hide background graphics.
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Fonts are one of the most important parts of a template, particularly 
when it comes to brand consistency. When you change the font, it will update 
all of the text, both titles and bullets, in your presentation.

To set your fonts, select the Slide Master tab, click Fonts, and then Customize 
Fonts. You can choose your preferred combo from the drop-down menu.

Theme fonts
If you want to use a custom font, for example one that is part of your brand 
guidelines but not a default PowerPoint option, you’ll need to embed the font. 
To embed a font, follow this path:

PowerPoint > Preferences > Output and Sharing > Save > and under Font 
Embedding, select Embed fonts in the file.

Embed custom fonts
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You’ll also want to make sure that there are no unnecessary fonts in your template. 
These won’t hurt anything, but they will cause confusing error messages to pop up 
when you save.

To confirm that you don’t have any unwanted fonts, go to Format > Replace Fonts. 
Scan through the dropdown list, and if you see any that you don’t want included, 
you can select a font to replace it.

Remove unwanted fonts
Once you’ve selected the elements you want to include, you’ll need to save 
your theme. Your theme includes the colors, fonts, and other visual elements 
that should be a part of your presentations. Note that each theme has its own 
slide master and related layouts. 

Once you’ve made your selections, click the Theme drop down and choose 
Save Current Theme.

Saving your theme
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Now that you finished choosing the elements of 
your template, you’ll need to save it for future use. 
Rather than the standard .pptx, a PowerPoint 
template is saved as a .pptx.

In the File menu, click Save As Template. From there, 
just name your template, choose a location to save it, 
and you’re ready to go!

Once you are ready to use your template for a new 
presentation, just go to File > New from Template.

Saving your template
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Keep file size small
Ideally your template should stay 
under 10MB, but at least keep 
them under 25MB to make it easy 
to share over email. 

If your file is too large, you 
can compress the images 
to 150 ppi, or crop out any 
unused parts of pictures.

There’s a lot going on in templates, but they are simpler to make and use than it might seem. 
Here are a few tips and tricks that will help you get started with building and using templates.

Pick System fonts
While custom brand fonts can look 
nice, they cause issues if you’re 
sharing a template or presentation 
with someone who doesn’t have 
your font on their computer. 

We recommend choosing 
a System font that’s likely 
to be on most computers.

Paste content, not slides
If you copy and paste a slide from 
a presentation that uses a different 
template than the one you are 
working in, it will add elements 
that aren’t part of your template 
as well as other inconsistencies. 

Instead, rebuild slides  by pasting 
the content into a slide  from your 
template piece by piece.

Design for accessibility
In general, it’s a best practice 
to use the built-in Accessibility 
Checker as you go. 

This ensures that accessibility 
concerns are addressed before users 
start building on your template.
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Applying your template to other programs

Even though you created it in (and for) PowerPoint, you can also use 
your template in other presentation programs, like Google Slides or Keynote. 
However, be prepared for certain elements not to transfer properly.
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As a result, you should review your template and a few sample slides to see 
if anything broke during the transfer. We’ve found that complex elements 
like SmartArt, charts and tables, animation, and interactivity will need to be 
fixed once you bring your template into another program. 

Here’s a list of some of the most common compatibility issues when 
transferring templates between PowerPoint and other presentation programs:

• Font and type

• Animation

• Template and layouts

• Shapes

• Images

• Charts and tables

• Hyperlinks and interactivity



Conclusion

Templates are a powerful tool for streamlining the 
way you make presentations. And for businesses 
with lots of PowerPoint users, they can be the best 
way to ensure brand consistency and elevate the 
overall quality of presentations. Once you learn 
the basics of creating, editing, and using templates, 
you’ll see the benefits almost immediately. 
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Looking for more information about templates 
and beyond? Check out our resources for expert 
advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks
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Typography 
101
Typography is one of the most important 
elements of a presentation. 

It's unique in that it does two things 
at once: it’s a decision about how you make 
content clear and easy to read, but it’s also 
an expression of your visual brand.



Principles of typography
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For all the countless fonts and many ways to use 
them, typography is actually a less complicated topic 
than it seems. 

In this guide, we’ll cover the general principles 
of typography, and best practices for using type 
in presentations.

While these two terms are often used interchangeably, there is actually a distinction between them. 
Technically, a typeface is the overarching family (e.g. Arial), while a font is the specific iteration 
of that typeface that you use in a document (e.g. Arial Bold). But since font is more commonly used, 
we’ll be using it as a general term for all things type in this blog.

Font vs. Typeface

FontTypeface

Arial 
BoldArial
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Serif and Sans serif System vs. Google vs. Brand fonts
You can group all fonts into two categories: serif and sans serif.

“Sans” comes from the French word for “without”, so fonts 
can come with or without the decorative tails known as serifs. 

A serif is a decorative stroke on the end of letters. They originate in traditional 
printing techniques, and tend to be seen as professional, traditional, 
or formal. Serif fonts are often used in body text, as the serifs make each letter 
clear and legible, even at a small size.

Sans serif fonts don’t have that end stroke on each letter. This creates a clear 
look that is commonly considered to be more modern than serifs. Sans serif 
fonts are popular in digital spaces like apps and social media. They are also used 
for things like wayfinding – the font for U.S. highway signage is in Clearview )

With these types of fonts, the difference comes from who makes or offers them, 
rather than their look.

System fonts are the ones that are included with most devices. In other words, 
the fonts you see when you open PowerPoint for the first time. Some examples 
are Arial, Times New Roman, Calibri, Courier New. Infamously, this category also 
includes Comic Sans and Papyrus.

Google fonts are fonts that are licensed by Google for anyone to download for 
free. They offer similar alternatives to many other fonts, as well as optimization 
for web use.

Brand fonts are just fonts that have been chosen to represent a specific brand. 
This means they can be any type or come from anywhere. Some are even 
custom created for that brand.

San SerifSerif GoogleSystem Brand
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https://www.adobe.com/creativecloud/design/discover/serif-vs-sans-serif.html
https://fonts.google.com/knowledge/glossary/system_font_web_safe_font
https://fonts.google.com/about
https://fontsinuse.com/in/2/formats/9/branding-identity


When picking presentation fonts, it comes down to two choices:
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Aesthetics
Sometimes you might choose a font because either you like the way it looks, 
or because it’s mandated by your brand guidelines. With purely aesthetic 
decisions, you are free to choose whatever you think best suits your 
presentation.

With brand fonts, this just refers to a font that is specified by your brand. 
These can be any category of font (system, Google, or custom), as they have 
been chosen specifically for their place in your larger brand vision. 

This can create a unique and ownable look in a presentation, but it also creates 
some challenges. If you are using custom brand fonts, you may need to embed 
your font to ensure that presentations render correctly and consistently on 
every machine. 

Usage
What fonts you use can be influenced by where you will be 
using them. For presentations, we recommend system fonts 
as a best practice. 

This matters most when you are sharing a presentation to someone 
on a different computer. System fonts are easily accessible to most 
users as they don’t require additional downloads, so everyone 
can open, read, and present a document with system fonts 
in place, without worrying if the appropriate font is downloaded 
or embedded. 

Using Google fonts is a fine option as well, as they’re quick 
and easy to download to your computer. However, they do require 
an additional step compared to using a system font. But Google 
fonts are a great resource for an exciting and refreshing variety 
of fonts to use if you’re looking for something a bit more unique. For PCFor Mac

VerdanaBold Guide  |  Typography 101



The right font for the right presentation

55

If you have a designated brand font, you will likely defer to that option for most of your presentations. 
If you are choosing your own fonts, there are a few guidelines we like to follow when considering font options. 

Before you choose a font, 
ask yourself these questions
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Is it legible: 
Can you easily read and understand 
the content with this font?

Is it appropriate: 
What does the look and feel of the font 
contribute to the content?



The right font for the right presentation
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Legibility 
is a core consideration of fonts, since they are essentially meant to 
communicate information. But appropriateness matters as part 
of legibility: some fonts aren’t readable, and that can be intentional 
for a number of reasons. 
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Appropriateness
can be challenging for people to determine, as there are not real rules 
to follow. But a good approach is to start with considering the audience 
for your presentation. For example, Comic Sans is more of a meme 
than a font at this point, largely because its playful appearance often 
contradicts the serious information it’s used to convey. It’s made 
to be playful with a faux-handwritten and bubbly aesthetic, so it's not 
great for every wedding invitation or the sign for a funeral home.

https://cba-design.com/italy/en/insights/comic-sans-2/


Legibility and appropriateness of fonts
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Here’s a real-world example 
of how this dynamic works.

Graphic designer David Carson famously 
(or infamously) used Zapf Dingbats, a font that 
is just pictographic symbols, for the text of an 
interview with English singer Bryan Ferry in the 
magazine Raygun because he felt the content 
of the interview was boring. This instance 
really seems to be the opposite of the guiding 
principles above, but it illustrates why these 
principles matter.

Is it legible? No, you can’t read or understand 
Dingbats on its own, but that’s the point – 
Carson doesn’t want you to because 
the interview is so boring that it's more 
interesting to look at a series of symbols 
than the content of the interview itself.

Is the font appropriate? Well, that depends on 
the audience. It might be if you’re interested 
in reading quality content, but it’s probably 
not if you’re Bryan Ferry.

David Carson, 1994, Ray Gun

Image: AIGA Eye on Design
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https://medium.com/@yopaulmiranda/david-carson-surfing-the-unconventional-waves-of-zapfs-dingbats-52a520186c64


Finding a suitable font
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Display and Body fonts

Not every font is meant to be suitable for every situation.

Display Body

Display fonts are fonts meant to be large and attention-
grabbing, like headlines or titles. These fonts have lots 
of personality to them to draw attention, however you 
wouldn’t use this category of font for long passages, 
not even more than a few words, because it’d be too 
difficult and overwhelming to read. 

The personality that some display fonts have also 
can be lost due to the scale, small details in the font 
can get shrunk out of existence. 

Body text, however, requires fonts that are meant to be 
read at a smaller scale. You can use a font meant for 
body text for a headline or at a larger scale  but it’s not 
recommended to do vice versa. 
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Choosing font sizes
Because presentations (and fonts) are all about conveying 
information, picking font sizes should start with what’s easiest 
to read. 

A good rule of thumb for fonts is that bigger is better – bigger text is generally 
easier to read in most use cases, whether it’s projected on a screen, shared 
virtually, printed out, or shared on a laptop. It’s also more accessible for those 
who may have vision impairment.

It’s also a best practice to stick to at most three different font sizes on any slide, 
and within your presentation overall. While your audience might not notice 
the specific changes in font size, using too many sizes will make your presentation 
messy and hard to follow.

Font size recommendations
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Font sizes for different application

There are a few general ways that fonts are used in presentations. 
Here’s how you can approach choosing font sizes in each area.

Title/Headline: Typically at the top of a slide or on the cover. 
This is usually the largest piece of type on your slide and draws the most 
attention, as it's the key message you want the audience to understand.

Subhead/Section: Usually below the title, it is often a more specific idea 
that is important but needs less attention than the Title.

Body: The text that makes up the primary content of a slide, 
it's usually smaller to accommodate more text, but still large enough 
for the audience to comfortably read.

Callouts: Labels within body text or on a chart/graph/map/etc. 
The size of these can vary depending on the content it is accompanying.

VerdanaBold Guide  |  Typography 101



When to use bold, color, and other emphasis
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Beyond the base font, there are a number of ways you can modify your 
text to emphasize certain information. The most common are bolding, italics, 
or underlining, but you can also apply color or size for emphasis.

Bolding text creates emphasis by darkening the appearance of letters, 
which comes from applying a thicker stroke around the letters. You can 
use the Bold function in your presentation program, or you can choose 
the “[typeface name] Bold” if the font you’re using offers it. If you are using 
the latter option, note that your font may include multiple weights 
(in other words, levels of bold) to choose from.

Italics set your type to slant towards the upper right. Italics are often used 
for names or titles (like of a book or source), and can be combined with bold 
or other types of emphasis to create hierarchy.

Underlining does just what it sounds like and places a line underneath 
your text. Be mindful of how you use underlining, as it can typically signify 
a hyperlink rather than simple emphasis.

Highlighting fills the area around your text with color. This can be useful 
for collaboration and editing, but can also be a way to add visual interest 
to your text.

ALL CAPS is a strong way to grab attention, and is often read as shouting 
or LOUD text. While useful in small doses, too much text in all caps can 
be hard to read.

Other MethodsBolding

Bold
Coloring

Color

Underlining

Highlighting

Italics

ALL CAPS

Here are a few of our best practices for adding emphasis 
to your text:
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Ligatures, kerning, 
leading, typesetting/
ragging a block of copy
While most type today is digital, much of 
the terminology comes from old-fashioned 
manual typesetting. These concepts are 
advanced, and most presenters won’t ever 
need to apply them, but there are situations 
where you might want to dig in and make 
some fine adjustments to your fonts. Ligatures

Ligatures were pieces of metal type that were made 
to solve the issue of letters physically colliding. 
The letters were commonly f with i/j/l/f or g with g/y. 
These visual overlaps can still be found in digital 
typesetting, though now ligatures usually are inserted 
automatically and most digital fonts will account 
for these letter combinations automatically. 

To check if your font uses ligatures, 
right-click in the text and select Font 
from the menu. Click the Advanced tab. 
Next to Ligatures, select Standard Only.

M Y R I A D  P R O ( S A N S  S E R I F )

S O U R C E  S E R I F  V A R I A B L E  ( S E R I F )
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Kerning and Tracking
Kerning and tracking refer to adjustments made to the spacing of letters.

Kerning refers to the spacing between individual 
letters. Most fonts are automatically optimized, 
but many programs allow you to manually adjust 
spacing if needed.

Tracking adjusts the spacing between letters overall, 
and is used for making the spacing consistent 
across your body text. It’s also more common 
in Microsoft Office programs. For example, tracking 
out letters that are all caps helps legibility since 
they are all a uniform height, which might make 
it hard for the eye to pick out specific words.

Leading refers to line spacing in Microsoft Office 
programs. Tighter leading can imply connection 
and flow, while looser leading can give space for large 
amounts of text to breathe. Too little and the text 
is cramped, too much and it can feel disconnected.

Narrow leading should allow for enough room 
for the ascenders and descenders of letterforms.

• Ascenders are the upward strokes of a letter

• Descenders are the downward strokes of a letter

F R O M  W I K I P E D I A

Line
spacing

Wide

Line

SpacingL O O S E  T R A C K I N G

NORMAL TRACKING

TIGHT TRACKING
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https://www.indesignskills.com/tutorials/kerning/
https://fonts.google.com/knowledge/glossary/tracking_letter_spacing
https://www.indesignskills.com/tutorials/leading-typography/
https://support.microsoft.com/en-us/office/change-text-alignment-indentation-and-spacing-in-powerpoint-36df6486-0118-4e95-b9bd-835eb047ac88
https://fonts.google.com/knowledge/glossary/ascenders_descenders
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Ragging
Ragging refers to the vertical edge on 
the margin of text. A lot of factors add up 
to create your rag – like font size, margin 
size, and sentence length – but ideally you 
want to create a consistent flow along the 
edge of your text.

In particular, a good rag reduces orphans 
and widows, which are words (or the ends 
of hyphenated words) that are left alone 
at the end of a text column /paragraph. 
They create a distracting amount of white 
space either at the beginning or end of text, 
and can be fixed by bringing more of the 
sentence down onto the line or adjusting 
columns so the word can be rejoined to 
the rest of the text.
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https://www.fonts.com/content/learning/fontology/level-2/text-typography/rags-widows-orphans


Conclusion

Understanding fonts is essential for good design 
and consistent branding. But you don’t have to 
be a trained designer to get the most out of your 
text – with a few key concepts, you can ensure 
legibility and a pleasing design, slide after slide!
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Looking for more information about fonts 
and beyond? Check out our resources for expert 
advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks
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Color is what brings a presentation to life. 
It’s how you highlight key messages, 
represent your brand, and create visual 
interest for your audience.

But using color properly can be 
a little confusing if you aren’t familiar 
with the fundamentals. 

Luckily, they are easy to learn and apply!



Using color in presentations

In this guide, we’ll cover the basics of color theory, 
dive into how to build a custom palette for your 
brand, and give you some best practices for more 
colorful presentations.
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Color theory is the basis for all the ways we use 
color. It’s both art and science, and it helps users 
to understand how they can use colors.

What is color theory?

Specifically, it’s the principles and rules that we 
use to choose, mix, and pair colors. It forms 
the basis of how we understand and engage 
with color in the world.



Why color matters

Color is a powerful tool for evoking emotions 
and building associations. Colors can inspire feelings, 
change moods, or provoke a wave of nostalgia. 

Think of traffic signals. Green is so strongly associated with “go” 
that the association now applies to almost any use of green, 
even outside the context of traffic.

We also associate general types of colors with certain feelings. 
Warm colors (orange, red, yellow) can suggest energy or action, 
while cool colors (green, blue, and purple) are seen as peaceful 
and relaxing.

Colors can be chosen for purely aesthetic reasons – your logo might 
be light blue simply because the founder loved the color. But since color 
can be such a powerful tool, there are also ways to use it strategically. 

68

“The color red is stimulating and is associated 
with being active. It also increases heart rate, 
which helps to jumpstart your appetite. The 
color yellow is associated with happiness and 
is the most visible color in daylight, so that’s 
why a McDonald’s logo is so easy to spot on 
a crowded road.”

Here’s a famous example of this idea in practice
Why McDonald’s uses red and yellow for their colors

This has led to companies trademarking their custom colors. Tiffany & Co. 
trademarked their famous blue, UPS has its own brown, and 3M even 
trademarked the special yellow of their Post It notes. These brands are so 
closely associated with their colors that they have become synonymous 
with the brands themselves.
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color relationships
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The color wheel
Using the color wheel, you can easily see the relationship between colors and understand how they will 
work together.

Red, blue, yellow Mixture of 2 primary colors: 
purple, green, orange

Mixing a primary and 
a secondary color

Primary colors Secondary colors Tertiary colors

Red, orange, yellow Green, blue, purple

Warm colors Cool colors
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RGB or CMYK
These groupings refer to where (and how) you are using colors. 

RGB uses the additive color mixing model, where 
you combine colors to make new ones. RGB is 
used on screens and other digital applications.

CMYK (Cyan, Magenta, Yellow, Black) uses a 
subtractive model, where you remove light to arrive 
at new colors. It’s used for printed documents.

Because PowerPoint is 
a natively digital platform 
(even if you do print out 
your slides), your presentation 
will always be in RGB. If you 
need to convert an image 
from CMYK to RGB, we 
recommend using another 
program to convert the 
images first, and then adding 
them to your presentation.
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Tints and Hues
On the color wheel, hues are pure colors. 
From there, you can add colors to create new variations.

Hue (Pure color)

Shade  (Add black)

Tone  (Add gray)

Tint  (Add white)

If you use Theme Colors in a presentation, PowerPoint 
will automatically create tints and shades for you.
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Hex values and Pantone colors
Since color can vary in so many ways, 
we use tools like hex values and Pantone 
to ensure we’re all using the same colors.
There are a few ways of ensuring that multiple 
people are using the same colors. The most common 
are using Hex values or Pantone colors.

To enter a specific Hex code in PowerPoint:
After opening your fill or text colors, select “More Colors” 
at the bottom. Then, select “RGB sliders” at the top of color types 
and you’ll see the option to enter the Hex code.

For reference: Pure white is #FFFFFF. Pure Black is #000000

Hex codes are a combination of 6 numbers and letters 
that identify a specific color. These are great for using 
colors across different programs.

Pantone colors use a numbering system to identify unique 
colors. They started in print, but now are the major color 
identification system in most industries.

#F2F2F2

Pantone 2244 C
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Creating your own 
palette in PowerPoint
You can build your own custom color 
palette in PowerPoint, so you’ll always 
have your brand colors ready to go. 

1. Go to the View tab and click Slide Master to 
access the Slide Master (or template) mode

2. Select colors, and then “Customize Colors…” 
to make your new color palette

3. Choose your colors. Name the palette 
and hit “Save.” 

4. Your custom color palette will now be 
available in your presentation
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Highlight key ideas
You can change the color of a key word or phrase on your slide to draw 
attention to it. This is a great way to make a key message pop, and to make 
sure the right point gets across.

Using color in subheads 
to emphasize sections

Using color within paragraphs to 
emphasize certain words an ideas

Add colored shapes
Brighten up a simple slide with a few shapes. This is a convenient way to arrange 
content, and it lets you add in more of your brand colors in an intentional way.
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Color your charts
You can add your custom colors to charts and graphs 
for a branded look that helps highlight information.

Add bars of color
With a field of color, you add a sense of organization 
that also directs the motion of the eye across the slide.

Bars across the top or bottom of a slide can introduce 
an idea or emphasize a takeaway.
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Use color in slide backgrounds
A full-color (or full bleed) background can add a powerful impact, 
particularly if you want to highlight a quote or key statement.

You can also use full-color slides as section dividers, to give 
a clear visual cue about the flow of your presentation.
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These dividers also add moments of visual excitement in long 
presentations. They are almost like a break for your audience.



Ways to add color to your slides
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Combine them all
Each of these tips works fine on its own, but you 
can also combine them for a design that’s both 
consistent and visually appealing. 
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Making colors accessible
Accessibility helps everyone to engage with your content, and it’s an important consideration when 
designing presentations. PowerPoint offers built-in tools to assess the accessibility of your presentation, 
but you can also consider these best practices for addressing accessibility issues with color.

Have adequate color contrast
Colors that are too similar can be hard to read. 

Use icons in addition to color
In cases where you are using color to communicate 
a message, such as a red box to indicate a warning, 
you can also use an icon to reinforce the message.

Add texture in addition to color
You can add to (or replace) colors with textures 
to clarify design elements in charts.

For more information, check out this article from Microsoft: Make your PowerPoint presentations accessible to people with disabilities.

Not enough contrast Not enough contrast

Enough contrast Enough contrast
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https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25


Conclusion

Color is a powerful and nuanced tool for enhancing 
your message and highlighting your brand. While some 
people might find it challenging at first, these basic 
principles and best practices should make it easy to add 
a new dimension to your presentations!
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Looking for more information about color 
and beyond? Check out our resources for expert 
advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks
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Images 101

From icons to photos to illustrations, images 
turn an otherwise standard presentation into 
a powerful visual experience.



Understanding images in presentations
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Images can enhance your content story, elevate your 
aesthetic, reinforce your brand principles, even draw 
connections with your audience. 

But elevating your slides isn’t just about adding 
images, it’s about adding the right images to support 
your story.

In this guide, we’ll cover the basics of imagery, 
explore some key ideas and best practices for 
choosing images in your presentations, and 
share some sources for finding the right image.

When you hear “images” you probably think about 
photographs. While that’s a big part of how images 
are used in presentations, it’s not the whole story.

Imagery in presentations refers to any visual 
representation that you use on a slide. This could 
be a photo, or it could be an illustration, an icon, 
or even a decorative element.

Typically, we judge an image based on appearance – 
in other words, is it aesthetically pleasing? This is 
a useful way to think, but when you are using imagery 
in presentations, you need to go one step further 
and think about what the image conveys. 

In general, we recommend using images that 
directly support the content story you want to tell, 
rather than those that just look good on the slide.

How to use images

If you don't learn from 
your mistakes, then 
they become regrets.
“

”
L A R R Y  I P S U M ,  C E O
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The choice between illustrations and 
photographs can set a strong tone 
in a presentation. But the choice isn’t 
about which to use – instead, it’s how 
to use both effectively.
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How to use your images
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When to use illustrations
Illustrations are great for showing fanciful or conceptual visuals. 
Some scenes just can’t be captured in a photograph, and illustrations 
can take your audience to new places.

Illustrations can also have a retro or classic feel. Before photography 
was widely accessible, illustrations were everywhere, and even now 
they can call us back to the past.

Finally, illustrations also cover icons. Icons are simple representations 
of things or ideas. They are great for reinforcing content, making 
slides more visual, and adding a unique feel to your brand.

Illustration is being used to give a friendly vibe
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When to use photographs
Photos excel at accurately portraying a moment or experience. 
They offer an accuracy and realness that can humanize a slide.

They are also great at conveying a professional vibe. If you want 
to seem earnest and authentic, photos are a great tool.

And photos are best at conveying the real experience of 
a product. There’s no substitute for showing people what you do.

Most presentations can benefit from a mix of both. Icons 
and photos work well together to tell a story in a visual style.

Photography is putting viewers in the moment
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Best practices for using images in PowerPoint

85

Watch out for pixelization
Too many images make it hard to scan your 
slide. It makes it harder for your audience 
to know where to focus their attention and can 
distract from your message. Using one strong 
image rather than multiple smaller ones 
helps keep your slides clean and focused.

Use high-quality files

Blurry / pixelated
Don’t select pictures that will be too blurry or pixelated

Crisp / clear
Be sure to use images that are high-definition 
to keep the presentation clean and professional
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Keep it clean
A blurry or pixelated image makes your slides 
look unprofessional. Make sure your images are 
high-quality before adding them to your slides. 
But note that pics that are too high-res might 
also make your file too large. If this happens, 
just compress the images to 150 ppi or crop 
out any unused parts of pictures.

Don’t overdo it with images

Too many images
Too many visuals on the slide will make it hard 
for the audience to focus

Just the right amount
Focus on one strong image to make your message clear
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Pick the right image 
for your audience
If your image doesn’t resonate with your 
audience, you’re going to lose them. Images 
that are too cheesy or seeming unserious 
might not work for an investor audience, while 
more authentic and high-quality ones might 
spark their interest.

Think about your audience

Cheesy
Pictures with the wrong tone can turn off 
your audience

More appropriate
Think about what will resonate with the audience 
before choosing
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What makes a good image?
A good image is one that helps support the content 
of your presentation. While there are many ways 
to assess the quality of an image, in presentations 
the real answer is just about functionality, rather 
than aesthetics.

That said, you may find yourself choosing between 
several similar types of images to support your 
content. To help you choose the right one, you 
can look at the following categories to see which 
image will work best for your presentation. 
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Relevance
Does this image make sense in the context 
of your presentation? Does it match 
the tone and brand? Is it consistent with 
any other images in the presentation?

Composition
The principles of composition can be complex, 
but you don’t need to understand any rules 
to pick good photos. Look for images with 
a clear subject and a balanced layout.

Attention to detail
This idea is about the little things that make 
a photo stand out. Small elements that draw 
the eye, focus or lighting that highlight key 
areas, and a composition that suits the subject 
can all add to the quality of an image.

Display of emotion
This doesn’t mean over the top emoting. Rather, 
it’s about finding authentic moments of real 
emotion. One of the common issues with images 
we see in stock images is photos that look very 
“posed.” It’s a common addition to many brand 
guidelines to direct creators to not use “people 
staring directly at a camera,” for example. 

Storytelling
Adding an image to a slide is a big deal. It draws 
attention, can distract the audience, and changes 
the balance of your layout. So if you’re going 
to include one, it needs to help tell the story 
of your content.

For example, a picture of a bike might not 
tell any particular story on its own. But a picture 
of a person on a bike, hands raised in the air 
as they cross a finish line, tells a very clear story.

Lighting
The lighting in an image can really set the 
emotional tone. A dark room has a very 
different vibe than the same space in a bright 
afternoon shot. 
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What are icons?
Icons are simple visual representations of specific 
objects. They are simplified drawings of objects 
or ideas that can be easily recognized, and make 
for a good stand-in for words on a slide.

Using icons instead of words helps you convey 
a lot of information concisely. It also adds to the tone 
and feel of your slides. 

An icon can add context or nuance to an idea, 
helping you tell a richer story without overloading 
the audience. 

How are icons used?
Icons are very useful for their simple and universal appeal. 

They can allow you to communicate a core action or idea with just a few 
lines, where otherwise it might take whole sentences of description.

Example slide layoutDON’T Example slide layoutDO
Example slide layoutDON’T Example slide layoutDO

SMART HEALTHY HAPPY EAGER

SMART HEALTHY HAPPY EAGER

Icons are one of our favorite tools for simplifying slides and making them more visual.

REINFORCING CONTENTMAKING SLIDES MORE VISUAL
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Creating an icon 
or illustration library
Building a library of brand-approved illustrations 
and icons can help you add consistency and clarity 
to slides. By establishing an illustration and icon 
library for your brand, you also create a unique 
voice and feel to your overall visual style.

Where to find images
While some brands have custom photography or illustrations, most images come 
from stock sites. Here are some of our go-to options for all types of images.

iStock
iStock.com is a subscription-based, royalty-free
stock photography provider. It has a huge range 
of assets for you to choose from.

Getty Images
Getty Images is a subscription-based service 
for great image assets. It’s one of the most popular 
choices for images.

Unsplash
Unsplash.com (by Getty Images) is a free resource 
for a wide range of images. It’s a great place to start 
your image search.

Nappy
nappy.co is free image site that’s focused on 
representing black and brown people in a way 
that’s purposeful and authentic.

Undraw
Undraw.co is a free resource for semi-customizable, 
open-source illustrations.

Ouch!
Ouch! offers free or subscription-based 
illustrations with a modern vibe.

Thenounproject.com is a library of free, 
well-designed icons that cover millions of topics. 
It’s also a good resource for stock photos. 

A good illustration library should be:
• Flexible enough for multiple channels

• Easy to use and update 

• Customized to your brand

• Consistent and clear
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https://www.istockphoto.com/
https://www.gettyimages.com/
https://unsplash.com/
https://nappy.co/
https://undraw.co/
https://icons8.com/illustrations
https://thenounproject.com/


Conclusion

Images can make the difference between a flat 
presentation and one that will move your audience. 
With so many images to choose from and ways 
to use them, it can be hard to know where to start. 

With these resources and concepts, you 
should have everything you need to create better 
presentations with powerful images.
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Looking for more information about imagery 
and beyond? Check out our resources for expert 
advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks
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From text zooming on screen to epic visual 
stories, PowerPoint animation can do more 
than most users ever realized.

But that capability also led to overuse, 
with folks creating complex and unnecessary 
animations that ultimately led to people 
believing that all PowerPoint animations 
were bad.

 



What is PowerPoint animation?
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The reality is that adding a few carefully chosen 
animations can add a level of polish and wow-factor 
to your presentations. And best of all, you don’t 
need a background in animation to make it happen!

In PowerPoint, animation lets you add motion and more to the visual elements on your slide.

This could be text, images, or even the transitions between the slides themselves.

Animation 101

Slide transitions are 
motion effects applied 
between two slides

Animation refers to 
motion effects applied 
to individual objects
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How will it be presented?
Animation works better in certain situations 
than in others.

In-person presentations are the best time 
to add animations. These presentations 
tend to be more visual and don’t suffer from 
issues like streaming lag.

Virtual presentations can sometimes have 
animation, but be careful: animations can look 
choppy over a stream. A virtual audience can 
also have more distractions, so interruptions like 
choppy animation can make it harder to keep 
their attention.

Printed presentations do not need animations. 

In-person

Okay to use animation 
when appropriate.

Yah

Virtually

Use sparingly. 
Animation can be choppy 

in video chat. 

Maybe

Printed

Why bother?

Nah
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Who is presenting
The type of presenter can impact the 
appropriateness of animation in a 
PowerPoint presentation.

People in sales who want to wow a potential 
customer find a lot of value in tools like 
animation.

Executives and senior leaders sometimes 
use animations, but tend to prefer a more 
streamlined design.

Presenters with lots of hard data to share 
want the focus on their credible content, 
not flashy aesthetics.
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Sales / marketing

Animation adds sizzle. 
Sizzle sells steaks.

Yah

CEO

Animate your keynotes. 
Use judiciously for board 

presentations.

Maybe

Finance

Most finance wonks 
are more concerned 
with data, numbers 

and trendlines.

Nah



When to use animations
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What’s the content
Finally, consider what’s on the slides before you 
start adding animations.

If you have highly-visual slides like you might 
see in a keynote presentation, where the slides 
are more like a visual aid, then animations can 
be very effective.

If the slides have dense or complicated content, 
there can be value in building the information 
onto certain slides piece by piece.

If you have lots of content and no way around 
it, then it’s best to leave the animations off and 
keep the slides straightforward.
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Highly visual

Presenter voices over 
slides, using 

the presentation 
as a visual aid.

Yah

Dense content

Building dense slides 
one piece at a time 

can reinforce learning.

Maybe

Brochure-like

Some presentations 
must function like 
a static brochure.

Nah



Types of PowerPoint animation
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PowerPoint categorizes animations into four different types of effects based on how they interact with a visual element.

ENTRANCE EFFECTS 

These effects make 
an object appear on 
a slide with animation

EXIT EFFECTS 

These effects make an 
object disappear from 
a slide with animation

EMPHASIS EFFECTS 

These effects modify an 
object already on a slide

PATH ANIMATION

These effects make an 
object disappear from 
a slide with animation
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Customizing PowerPoint animation
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Animation Pane shows you all the elements with animation, 
as well as the order they appear on the slide

Effects Options let you customize exactly how the animation works 
during the animation.

Timing Options let you specify when the animation starts, ends, 
how long it lasts, and more.

After you’ve chosen an animation type, PowerPoint gives you a range of options for customizing how it functions on your slides. 
With these options, you can customize exactly how your animation displays.
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The two main types of animation
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Animations vs. 
slide transitions
There are many types of animation you can use 
in PowerPoint, and we’ll get into the nitty-gritty 
details further in this blog, but at its core 
PowerPoint animation boils down to two areas: 
animations and slide transitions.

Animation refers to motion effects applied 
to individual objects. These animations take 
place within one slide.

Slide transitions are motion effects applied 
between two slides. They can also impact individual 
design elements on a slide, but they are really 
about the move from one slide to the next.
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Basics of PowerPoint animation
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How to use Slide 
Transitions in PowerPoint
PowerPoint offers a large selection of transitions 
to use between slides. But most of these 
options are too overpowering or fussy to fit 
in most professional presentations. 

The exceptions are the Fade, which is our go-to transition, 
and the Morph, which is a surprisingly powerful  tool.

Most transitions are going to be too much

Works great! More on this next
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Much robust. 
Very options.



Basics of PowerPoint animation
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If you don’t add any transitions, your slides will still look fine, but the 
movement from one slide to the next can be abrupt and inelegant.

Without transition, flowing between slides can feel jarring

With a Fade, you get a more polished look that is barely noticeable in all the right ways.

Adding a fade transition between slides is a quick way to add polish to your presentation
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No transition; movement 
between slides is abrupt

Fade slide transition applied between slides



Advanced PowerPoint animation
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The Morph transition is a little different
Morph is a slide transition that appears to add motion to objects that appear on two 
consecutive slides. For this reason, it tends to look more like an animation than a transition.

Let’s say you have a shape on a slide. If you duplicate that slide and change the size, color and location of the shape 
on the second slide, the morph transition will move the animation in-between the two states so that it appears to have motion. 

You can even change shapes completely (e.g. circle to square) or use it with text. 

Learning Morph can take some trial and error, as the results can sometimes be inconsistent. But once you figure out what works well with Morph and how to get 
the results you’re looking for, you can use it to quickly add motion that would take a lot longer to make using PowerPoints traditional animation tools.

Morph can be powerful but picky

Morph is a slide transition that appears to add motion to objects that appear on two consecutive slides. 

Pros: Quickly add impact that would take a lot 
longer with traditional animation.

Cons: It can be unpredictable and require a little 
trial and error. Keeping it simple helps.
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With so many options and ways 
to customize your animations, it can 
be a little overwhelming to figure out 
what works and what doesn’t. Here 
are some tips and best practices 
for PowerPoint animations that will 
help you get started. 

You can also check out our blog post 
on the top 3 animations to make any 
presentation look good for more tips 
on which animations to choose.

https://www.verdanabold.com/post/top-3-animations-that-make-any-presentation-look-good-power-point-101
https://www.verdanabold.com/post/top-3-animations-that-make-any-presentation-look-good-power-point-101
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Keep track of animation in Selection Pane
The Selection Pane lets you see, name, and reorder the elements on a slide. Any changes you make here to the names of elements 
will carry over to the animations tab, which can make it much easier to to keep track of objects when you’re building animations.

The Selection Pane functions allows you to 
quickly name and reorder elements on a slide. 
The naming structure carries over to the 
animations tab, making it easier to keep track 
of your objects for complex animations. 
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Preview your animation 
as you work
Since animations don’t play while you are editing 
a slide, it’s common to put the presentation 
into slideshow mode to view your work. Instead, 
you can use the “Preview” button in the Animations 
tab to see it play directly on your slide.

This can be a huge time saver as you work 
through the finer points of an animation.

This handy button plays a slides animation 
without having to enter slideshow mode. This 
can be a time saver when you’re working on 
a complex animation that requires adjustment. 
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The Fade is your friend
If there’s one animation type you can use over and over, it’s the Fade. It’s subtle enough to not get in the way, but useful enough to add polish to almost any deck.
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When can you use fade? 
Pretty much whenever! 

Use it any time you want to add 
a simple polish to your deck

It is subtle enough that your 
audience won’t fatigue from viewing 
this affect across multiple slides



Animation best practices
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Navigate tricky situations 
with Motion Paths
If you want an object to move in a certain way, 
you can use a motion path to specify the exact 
path it travels across your slide.

Motion paths can be used 
any time moving an object 
across the slide in a specific 
path to help reinforce 
the story. 
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Stick the landing with Rise Up
This style is a powerful way to highlight a key message or final takeaway on a slide. But be careful, it can quickly get overused.
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Rise Up can get a little intense 
when overused, but it can 
really hang a hat on your 
key message when used 
as the final word on a slide
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Add cinematic drama in key moments with Fly In
Fly In might be the most aggressive animation we employ, but it can really add some big screen drama if used intentionally.
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Fly In might be the most aggressive 
animation we employ, but it can 
really add some big screen drama 
if used intentionally
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Draw in lines and shapes with 
Wheel, Wedge, Wipe and Split
Combining the Wheel, Wedge, Wipe and Split 
with shapes that contain a linear element can make 
them appear to “draw in”. 

Note that these effects are less useful when 
applied to solid or blocky shapes.

Using Wheel, Wedge, Wipe and Split with shapes that contain a linear element 
can make them appear to “draw in”.

Using these effects on solid/blocky shapes is less successful in our opinion.
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Wheel Wedge Wipe Split
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Call attention
If you want to draw attention to a specific object 
on a slide, emphasis effects like Grow/Shrink or Spin 
can highlight key elements.

Use these when you want the audience to focus their 
attention in a specific spot on the slide. Emphasis 
effects also lend themselves well to combining with 
other animations (more on that below).
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Emphasis effects such as grow/shrink and spin can be used to draw 
attention to your object. 

Use when you want audience to focus their attention in a specific spot.

Emphasis effects also lend themselves well to combining with other 
animations (more on that next).

Grow / Shrink Spin



Advanced PowerPoint animation tips and tricks
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Combine animations to power up your point
Once you’ve mastered simple animations you can start to create combos for bonus impact. 
For example, you can combine Zoom and Grow/Shrink to have an element pop onto the slide, 
or you can combine the Spin effect with a motion path to have a circle roll across the screen.

There’s a ton of customization available once you get comfortable with combining the many 
types of animation effects PowerPoint offers.

++

After you’ve mastered the basics of PowerPoint 
animation, there’s still a lot more to learn. 

Here are a few ways to elevate your animations 
and add a new level of polish.
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Zoom + Grow / Shrink Spin + Move
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Combine video & animation 
for some sizzle
It might seem like a lot, but there’s a powerful combo 
to layering animation over a video. This is a compelling 
way to add a high impact slide to any presentation.

For more on using videos in presentations, check out 
our blog on movies and animated GIFs in PowerPoint.

Video can play behind 
animation and even be 
tailored to interact with 
other objects on the screen. 

Use this when you need 
a moment of high impact 
in a presentation. 
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https://www.verdanabold.com/post/powerpoint-101-movies-and-animated-gifs-in-powerpoint
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Add animation 
to the Slide Master
If there are certain core animations that you always 
want to be a part of your presentations, or you want 
to make sure other people in your team don’t alter 
any carefully crafted animations, you can add them 
directly into the Slide Master.

This lets you bake them directly into the template, 
which also means they aren’t accessible in the 
standard slide edit mode.

Animations and videos can also be added 
to slides in the master section so that they 
are baked into the template and inaccessible 
in regular slide edit mode. 

Use this when you want to lock motion 
elements down at a template level to avoid 
users from altering the animation. 
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Conclusion

PowerPoint animations are an underappreciated 
but highly-useful tool for adding polish and visual power 
to presentations.

While animation can seem like a complicated or advanced 
technique, with a little practice it can be easy to add this 
visually appealing technique to your presentation toolkit.
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Looking for more information about presentation 
animation and beyond? Check out our resources for 
expert advice and tested strategies.

• Storytelling

• PowerPoint design

• PowerPoint tips and tricks

https://www.verdanabold.com/blog/categories/storytelling
https://www.verdanabold.com/blog/categories/powerpoint-design
https://www.verdanabold.com/blog/categories/powerpoint-tips-tricks


For help with presentation 
design, storytelling 
and training, just say 
hello@verdanabold.com 

More ways to learn

Subscribe to our newsletter

Follow our blog

Train your team

Thank you!

mailto:hello@verdanabold.com
https://www.linkedin.com/newsletters/7066453379782246400/
https://www.verdanabold.com/blog
https://www.verdanabold.com/training

